
 

 

实验三 

基于虚拟仪器技术的弗兰克-赫兹实验 
【目的要求】 

（1）了解虚拟仪器的概念； 

（2）了解图形化编程语言 LabVIEW，学习基本的 LabVIEW编程； 

（3）利用虚拟仪器技术完成自动化的弗兰克-赫兹实验。 

 

【仪器用具】 

计算机，LabVIEW 2016，数据采集卡，弗兰克-赫兹管（充汞或氩），FH-1型弗兰克赫

兹实验仪（包括两组直流电源、两个弱电流放大器和一个加速电压放大器），100 Ω 标准电

阻，元件盒一个（包括 1 kΩ、100 Ω待测电阻各一个），导线、接线柱若干。 

 

【实验原理】 

1、虚拟仪器的概念 

通常的电子测量仪器包括信号输入、分析处理、显示和控制几个部分。例如，在传统的

示波器中，利用探头来输入信号，在显示屏上显示信号，有些示波器还具有对输入信号进行

处理和分析的高级功能。对于整个测量过程，我们可以通过示波器前面板上提供的控制按钮

或触摸键进行控制。 

迄今为止，我们一般接触到的都是传统的独立仪器，如模拟示波器、数字万用表、函数

发生器等。传统独立仪器存在一些显而易见的缺点：数据显示形式比较单一，数据处理功能

比较简单，不容易根据需要自行改装，不能共享数据，自动化程度低，等等。随着计算机和

网络技术的发展，计算机在处理数据、通信方面的长处日益显露出来，人们开始想把计算机

应用到测量上来，一种思路是把计算机装入仪器，这就是智能化仪器的思想；另一种思路则

是把仪器装入计算机，这就是虚拟仪器的思想。把仪器装入计算机意味着测量是以计算机为

中心的，测量对象的信息必须变成计算机能处理的信息，对测量对象的控制也是由计算机发

出，而用户则通过计算机来控制测量过程和了解测量结果。因此，虚拟仪器实际上就是一种

基于计算机的自动化测试仪器系统，它利用通用计算机的强大计算处理功能，通过传感器和

接口卡实现信号输入，用键盘、鼠标、显示器等计算机外设实现控制和显示功能。使用者可

以根据需要自行设计仪器，体现了“软件就是仪器”的新概念。虚拟仪器设计过程主要包括选

择适当的硬件平台和传感器、接口卡，以及编写控制程序。比如，用虚拟仪器方法实现示波

器的功能，只需要一台个人电脑，一块模数/数模转换卡，加上专为示波器功能编写的软件

就可以；而同样的硬件设备，加上为实现函数发生器功能而编写的软件，还可以成为一台函

数发生器。相比传统仪器，虚拟仪器的功能更加灵活多变、易于扩展，如果结合网络技术，

还能够与外界进行数据通信，实现远程操作。因此，虚拟仪器技术已经成为当前自动化测量

的主流技术，并且在很多前沿的科研实验中得到广泛应用。 

2、虚拟仪器的硬件 

本实验使用的硬件平台是个人电脑（PC机），接口卡使用 NI（national instruments）公

司的数据采集卡（DAQ卡）。有些应用中要测量非电学量，还需要使用传感器将非电学量转



换成电学量进行测量，比如测量温度，就可以利用铂电阻传感器连接成非平衡电桥电路将温

度信号转换成电桥的非平衡电压，再用采集卡测量电压。如果用采集卡输出电压，在所需输

出电压或者功率很大的情况下，还需要在输出端加上电压或者功率放大电路。 

本实验所用的 DAQ卡（NI USB-6343型）采用 USB接口传输数据，使用起来非常方便、

灵活，便于携带。DAQ卡可以实现对输入电压信号的采集、放大以及模/数转换，以及将计

算机数字信号转换为模拟电压信号进行输出的功能，因此既可以进行测量，也可以实现控制。 

数据采集卡的主要性能指标包括：输入通道数、信号输入方式、输入范围、阻抗、A/D

转换器的采样速率和位数、分辨率和精度等。本实验采用的数据采集卡可同时采集 32路单

端或 16路差分输入信号，采集的信号电压范围从±0.2 V到±10 V分成四挡，分辨率为 16位，

最高采样率为 500 kS/s（S/s 即采样点数/秒）；可同时输出 4 路模拟信号，最高输出速率为

900 kS/s。 

使用数据采集卡之前要正确安装硬件和驱动程序。同时还要根据需要在采集卡管理软件

中恰当设置信号输入方式，比如是采用单端参考地输入还是双端差分输入。 

采集原理详细内容请参考相关参考书。 

3、虚拟仪器的软件 

用于虚拟仪器系统开发的比较成熟的软件开发平台主要有两大类：一类是通用的可视化

软件编程环境，如 VC++、VB等；另一类是专用于虚拟仪器开发的软件编程环境，如 Agilent

的图形化编程环境 Agilent VEE 和 NI 公司的 LabVIEW，以及后者的文本编程环境

LabWindows/CVI。 

本实验使用的是 LabVIEW（laboratory virtual instrument engineering workshop）开发平

台，它将计算机数据分析和显示能力与仪器驱动程序整合在一起，为针对仪器的编程提供了

很大的便利。而且，LabVIEW 是一种图形化编程语言，编程过程也就是设计流程图，即使

初学者也能很快入门。 

用 LabVIEW开发平台编制的虚拟仪器程序简称为 VI。VI包括三个部分：前面板（Front 

Panel）、程序框图（Block Diagram）和图标/连接器。 

前面板用于设置输入数值和显示输出量，相当于真实仪表的前面板。前面板上的图标，

分为两类：输入类（Controls，用于输入）和显示类（Indicators，用于输出），具体可以是开

关、旋钮、按钮、图形、图表等表现形式。程序框图相当于仪器的内部功能结构，其中的端

口用来和前面板的输入对象和显示对象传递数据，节点用来实现函数和功能子程序调用，框

图用来实现结构化程序控制命令，连线则代表程序执行过程中的数据流。 

关于用 LabVIEW编写程序的进一步知识请查看附录 1。 

4、利用虚拟仪器测量电阻的伏安特性曲线 

为了便于入门，可以首先练习用虚拟仪器测量最简单的线性电阻的伏安特性。实验中利

用采集卡的一个输出通道为整个测量电路供电，利用两个输入通道分别测量总电压和标准电

阻上的电压；利用测量得到的电压数值和标准电阻数值就可以得到电路中的电流以及待测电

阻上的电压。在程序控制下，电路电压由 0 V开始逐渐增加到 5 V，输出电压每改变一次，

测得一组电压、电流值，最后得到一个数组，经过线性拟合后就可以得到待测电阻值。测量

原理见图 3-1。使用单端输入方式时，采集卡的各个输入通道共用地线，各通道测量的都是

对地的电压，连线时要加以注意。 



 

图 3-1 用虚拟仪器测量待测元件的伏安特性曲线的原理图 

5、利用虚拟仪器技术实现自动化的弗兰克-赫兹实验 

弗兰克-赫兹实验是物理学历史上的经典实验之一，设计思想非常巧妙，通过简单的伏

安曲线测量，首次在实验上验证了原子能级模型，因此获得了 1925年的诺贝尔物理学奖。

关于该实验的基本原理详见教材《新编基础物理实验》（第二版）的实验十八。本实验中，

我们将利用虚拟仪器技术实现自动化的弗兰克-赫兹实验。 

 

【实验装置】 

DAQ卡：通过 USB接口连接到计算机。一体式计算机的 USB接口在显示器的左侧和

后侧。DAQ卡中已经接出了需要用到的引线，包括三个模拟输入通道 AI 0、AI 1和 AI 2，

两个模拟输出通道 AO 0和 AO 1，以及模拟输入地 AI GND和模拟输出地 AO GND。DAQ

卡通过外接电源供电，电源开关在卡的侧面，使用时打开。注意：对 DAQ卡进行接线操作

时必须关闭卡侧面的电源开关！以免带电操作损坏 DAQ卡。 

弗兰克-赫兹管：弗兰克-赫兹管位于加热炉的中央，通过温控器可以监测和控制温度。

按面板左下方的 set键，温度示数闪烁后用上、下箭头调节设定温度，左右箭头用于选择要

设定的位，设定完成后再按一次 set键进行确认。温度显示上方的红字为当前实际温度，下

方绿字为设定温度。汞管需要利用加热炉加热到合适温度，氩管无需加热。炉子的面板上标

出了弗兰克-赫兹管各个电极的接口。 

FH-1型弗兰克-赫兹实验仪：这台我们自主加工的仪器包括两组直流电源、两个弱电流

放大器和一个加速电压放大器。两组直流电源分别提供灯丝电压 UF和实验中的控制电压，

调节范围 0～5 V，两组电源的绝对电位是独立悬浮的，彼此间的电位由外电路决定。1路和

2路弱电流放大器的测量范围分别包括 10-4、10-5、10-6和 10-6、10-7、10-8三挡，实验中测量

微弱的板极电流 IP时，应选择 2 路弱电流放大器的 10-8或 10-7挡，同时将切换开关拨向 2，

使上方的显示屏显示 2路放大器的输出电压。加速电压放大器用来将采集卡的输出电压进行

放大，实验中所需的加速电压达到几十 V，而采集卡的最大输出电压范围是±10 V，因此需

要借助加速电压放大器中的高压运算放大器对输出电压进行放大，放大器的放大倍数包括 2、

5和 10三挡。 

   

图 3-2 DAQ卡和 FH-1型弗兰克-赫兹实验仪 

 



【实验内容】 

1、 初步熟悉 LabVIEW开发环境的基本操作和编程方法 

由开始→所有程序→NILabVIEW2016 (64-bit)或者由桌面快捷方式启动 LabVIEW 2016

程序。点击 Create Project，然后选择 Blank VI，点击 finish进入 LabVIEW环境。首先看到

的是灰色的前面板。点击 Window→Show Block Diagram可以显示程序框图。在前面板，点

击 View→Controls Palette和 Tools Palette可以分别显示控件选板和工具选板（参见图 3-3）。

旋钮、开关等控制量在控件选板上，选择这些图标并将其放置在前面板上，那么相应的端子

和图标会出现在程序框图上。通过这些控件图标可以在前面板输入控制程序中的数据，或者

将程序运行结果显示出来。在程序框图窗口中，点击View→Functions Palette显示函数选板，

利用函数选板提供的循环、数学运算、比较以及公式节点等函数功能可以创建框图程序。自

己试着熟悉一下各选板上的图标和名称，学习选择并放置控件、点击右键查看快捷菜单，学

习使用标签工具、定位工具、连线工具，熟悉各种快捷键，各种操作的详细说明见附录 1。 

 

图 3-3 LabVIEW 2016开发环境图。左侧是前面板窗口，右侧是程序框图窗口。 

2、 练习用虚拟仪器测量电阻的伏安特性曲线 

下面通过一个简单的具体实例，也就是测量电阻的伏安特性曲线，来学习虚拟仪器的基

本使用方法。 

（1）编写程序，包括前面板和程序框图 

前面板图和程序框图如图 3-4和图 3-5所示。详细的编写过程在附录 2中给出。 



 

图 3-4伏安法测电阻的前面板图 

 

图 3-5伏安法测电阻的程序框图 

（2）正确连接采集卡和外部电路 

按图 3-1连接电路。用 DAQ卡的模拟输出端口 AO 0给电路供电，用模拟输入端口 AI 0

和 AI 1分别测量电路的总电压和标准电阻上的电压，并将模拟输出的 AO GND端口和模拟

输入的 AI GND端口连接到图 3-1中的地端（DAQ卡各个连线对应的端口参见 DAQ卡上方

的铭牌，上面标出了不同数字端口对应的端口标号）。 

（3）运行程序 

将前面板窗口中的标准电阻值设为 100 欧姆，采集时间间隔设为 1s，按下开关，然后

点击屏幕左上角的右箭头运行程序。分析实验结果。保存程序并退出。 

3、 用虚拟仪器技术实现自动化的弗兰克-赫兹实验，测量第一激发电位 

（1）设计自动化弗兰克-赫兹实验的基本实现方案和具体连线方式 

考虑实验中哪些电压可以用 DAQ卡通过程序控制，哪些电压由弗兰克-赫兹实验仪提供，

彼此间如何连线。注意：除了弗兰克-赫兹实验仪中的两组直流电源的电位是浮动的，弱电

流放大器和加速电压放大器的负接线端都是接地的，并且 DAQ卡的模拟输入地和模拟输出

地也都是接地的，因此，接线时必须考虑到共地问题，正确设计电路接法。请先自行独立设

计自动化弗兰克-赫兹实验的接线方案，正确提供各个控制电压，然后与附录 3 中给出的答

案进行比对，最终务必按附录 3中的接线方式进行连接，以免错误接线损坏仪器！ 

（2）编写自动化弗兰克-赫兹实验的控制程序 

可以从头编写控制程序，当然更简单的是直接对电阻的伏安特性曲线测量的控制程序进

行修改。将电阻的测量程序另存为弗兰克-赫兹实验程序（另存时选择第一个选项，也就是



Copy→Substitute copy for original），然后对程序进行修改。要求控制程序可以输入起始扫描

电压、终止扫描电压、扫描电压间隔等基本参数。为了保证安全，程序中要能够设定最大允

许信号电压，一般在弱电流放大器为 10-8挡时，要求输出电压信号绝对值不超过 5 V；而在

10-7挡时，输出电压信号绝对值不超过 1 V。数据采集结束后程序要将输出电压信号重新设

置为 0，以保障安全。采集结束后还要将测量数据保存到文件中 (可以用

Functions→Programming→File I/O下的Write Delimited Spreadsheet函数实现），方便之后的

进一步处理。附录 4中给出了由电阻伏安特性程序修改得到的弗兰克-赫兹实验程序的截图，

以及主要改造过程的简要说明。程序编写过程中可以先使用氩管进行实验，因氩管无需加热，

比较简单，并且已经提供了大概的参考电压参数。 

（3）正确连接采集卡和外部电路，并运行程序 

按附录 3中的说明连接电路，特别注意加速电压放大器的红色输出线输出信号为高压，

务必保证正确连线并注意安全！程序运行过程中不能触摸。之后先在比较小的电压下和比

较小的电压扫描范围内对程序进行测试，检查各个部分是否正常，比如最大允许信号电压是

否可以正确工作（检验时可以先将这个值设的比较小）。如有问题，可以在数字万用表的帮

助下判断问题所在。确认采集程序可以正常工作后保存程序，再正式进行数据采集。 

4、 研究各参数对汞的第一激发态测量实验曲线的影响 

分别改变各个参数，利用程序进行数据采集，研究不同参数对汞的第一激发态测量实验

曲线的影响。对于汞管，电压扫描范围可以选择为 0～40 V，扫描电压间隔可设为 0.1 V。

注意灯丝电压 UF每次变化不能太大（0.25 V），以免板极电流过大，并且改变后要等待两三

分钟至阴极状态基本稳定后再进行测量。 

5、 测量汞原子的高激发态（选做） 

尝试改变温度和接线方式，并对各个参数进行优化，测量汞原子的高激发态。高激发态

的测量原理参见教材《新编基础物理实验》（第二版）中实验十八的附录部分。先自行设计

接线方案，然后按附录 3中给出的答案进行连接。电压扫描范围可以选择为 0～30 V。实验

过程中要特别注意监控板极电流，以免低温下弗兰克-赫兹管被击穿！ 

 

【思考题】 

（1）你对虚拟仪器系统在物理实验中的应用有何设想？能否结合具体的实验给出一个

简单的设计思路。 

（2）本实验中为什么不同时测量待测电阻上的电压和标准电阻上的电压？ 

（3）用虚拟仪器测电阻伏安特性并计算其阻值时，结果的误差可能来源于哪些方面？ 
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【附录】 

1、 LabVIEW编程简介 

（1）新建 LabVIEW程序 

双击 LabVIEW 2016 图标，出现启动画面，点击左侧窗口的 Create Project，然后选择

Blank VI，点击 finish进入 LabVIEW环境，就可以打开一个新的 LabVIEW程序，可以看到

它由前面板（Front Panel）和程序框图（Block Diagram）组成。如果要打开一个已有程序，



点击右侧窗口的 Open Existing，然后选择要打开的程序。 

（2）前面板窗口（Front Panel）和控件选板（Controls Palette） 

前面板窗口是用户界面，也就是 VI的虚拟仪器面板。前面板上面有两类控件：输入控

件（controls）和显示控件（indicators）。输入控件有开关、旋钮、数字或文本输入框等，用

来让用户进行输入或控制操作。显示控件有图形、数字或文本输出框等，用来显示测量或计

算结果。 

所有控件都要通过控件选板进行选择，再添加到前面板上。控件选板可以用两种方法打

开：1）在前面板空白处点击右键；2）选择菜单 View→Controls Palette。 

控件选板如图 3-3左图所示。其上的控件主要按照数据类型分组。寻找控件有两种方式：

1）根据所属类型找到其分组，再在该分组中找到该控件并点击；2）如果知道控件名称，还

可以利用控件选板上的搜索栏（Search）直接搜索，双击搜索结果可高亮显示其在选板中的

位置。 

向前面板添加控件的方法：鼠标左键点一下控件图标并松开，控件就粘附在光标上了；

将光标移到要放控件的位置，再点一下鼠标左键，就将控件释放了。 

对于某些数据类型的输入（或显示）控件，可以在该控件上单击鼠标右键，选择 Change 

to indicator（或 control），将其改变为同一数据类型的显示（或输入）控件。 

（3）程序框图（Block Diagram）和函数选板（Functions Palette） 

创建前面板窗口后，还需要在程序框图中编写图形化代码，用来控制前面板中的对象。

前面板和程序框图之间的切换，可以直接用鼠标在不同窗口点击；如果窗口已经全屏，可以

点击 Window→Show Front Panel（或 Show Block Diagram）进行切换。在程序框图中，可以

看到添加在前面板上的控件在程序框图中已经生成了相应的输入、输出端。此外，可能还需

要在程序框图中添加一些子 VI、函数、常量、结构和连线（用来在对象间传递数据），才能

实现仪器的输入和输出功能。 

在程序框图中，我们可以看到输入控件和显示控件的图标有两个显著区别：1）输入控

件的边框较粗，显示控件的边框较细；2）它们的图标上都有一个表示数据流向的接线端箭

头，输入控件的箭头向外，而显示控件的箭头向内。 

向程序框图中添加子 VI、函数、常量、结构，需要通过函数选板来选择和添加。函数

选板如图 3-3 右图所示。打开函数选板也有两种方法：1）在程序框图空白处点击右键；2）

选择菜单 View→Functions Palette。 

如果知道对象名称，可以使用函数选板上的搜索功能查找对象。双击搜索结果可高亮显

示其在选板中的位置。 

如果要查看函数或 VI 的功能，可将鼠标移到控件上，按快捷键<Ctrl+H>，即可出现

Context Help窗口并出现相应的说明，点击窗口中的 Detailed help将出现更详细的说明信息。 

（4）数据流、连线和数据类型 

数据流工作方式 

LabVIEW 按照数据流模式运行程序，只有当模块要求的输入数据完全到达这个模块时

才能执行，然后向其所有的输出端口输出数据，这些数据再沿数据线流向其它模块。数据流

经节点的过程决定了程序框图上 VI和函数的执行顺序。 

在数据流模式下，两个彼此没有数据依赖的程序块可能会同时运行，如果要强制它们的

运行顺序，可以使用顺序结构（Flat Sequence）或错误簇（Error）等编程技术。 

连线 

连线用于在程序对象之间传递数据。连线上数据的传递是有方向的。输入端子、常数、

函数或子 VI 的输出端都可以作为数据源。数据接收端可以是显示端子、函数或 VI 的输入

端。一条连线只有一个数据源，但可以连接多个数据接收端。此外，连线上传递的数据具有



一定类型和维数，其数据源和数据接收端的数据类型和数据维数必须相同。因此，正确的连

线必须保证两点：1）连线方向正确；2）连线输入和输出端必须与连线上传递的数据兼容。

表 3-1显示了最常见的连线类型。 

表 3-1 常用连线类型 

类型 标量 一维数组 二维数组 颜色 

整型 

   

蓝色 

浮点型 

   

橙色 

布尔型 

   

绿色 

字符型 

   

红色 

当连线错误时，连线会表示成断线，它是一条中间带小红叉的黑色虚线。这时你应将连

线工具移动到它上面，LabVIEW会给出两端的数据类型和流向信息，你可以检查并改正。 

添加新的模块和连线可能会对已设置好的部分有影响，而且原来的错误连线也可能对新

添加的连线有影响。 

如果已经连了一个接线端，想取消连线，可单击鼠标右键。如果想删除连线，用定位工

具选中它，即可删除。 

连线结束后，右键单击连线，从快捷菜单中选择“Clean Up Wire”，可使 LabVIEW自动

选择连线路径。按快捷键<Ctrl+B>可删除在程序框图中的所有断线。 

数据类型 

LabVIEW的基本数据类型有五种：Numeric（数值）、Boolean（逻辑）、String（字符串）、

Enum（枚举）、Ring（环型枚举），Ring和 Enum很类似，可以循环枚举。 

Numeric类型的数据按精度又分若干种类型，与标准 C++的数据类型基本是一致的。其

代表符号直观的表现其类型。可以在数值对象上点右键，通过弹出菜单中 Representation修

改类型。在程序框图中，不同数据类型的对象有不同颜色，其颜色和数据类型的对应关系与

连线相同。 

（5）工具选板功能介绍： 

在前面板窗口和程序框图中都可以使用工具选板（见图 3-3），可以通过 View→Tools 

Palette打开和关闭它。它提供了各种用于创建、修改和调试 VI程序的工具。当从选项板内

选择了任一种工具后，鼠标箭头就会变成该工具相应的形状。工具选板上的 是

控制自动选择工具的开关：当灯亮时，鼠标如果移到某个模块上，程序会自动选择工具，方

便操作。 

下面介绍常用工具按钮的功能： 

：操作工具（Operate Value），用于操作前面板的控制和显示，比如按下开关、扭动

旋钮等；或者用于改变程序框图中布尔常量的值。当使用它向数字或字符串控件中键入值时，

工具会变成标签工具。 

：定位工具（Position/Size/Select），用于选择、移动或改变对象的大小。1）选择对

象：点击一个控件，就可选中它；如果想选择多个控件，可以用鼠标在屏幕上拉一个框，这

时框中的控件同时都被选中。选中对象后，可以移动、复制或删除该对象。2）移动对象：



左键点击对象并一直按住，待移动到目标位置之后再松开。3）改变对象大小：选择对象后，

将光标移动到边框上，此时矩形边框四角和四边中央会出现小方块，将光标移到小方块上时，

光标会变成相应的双箭头形状，此时可以沿所需的方向对对象拉伸或压缩。 

：标签工具（Edit Text），用于向输入控件中输入文本、编辑文本或者创建自由标签。 

：连线工具（Connect Wire），用于在程序框图中连接对象。连线方法：将连线工具

移至接线端，此时将出现含有接线端名称的提示框，而且图标上的接线端将会闪烁。由于有

的函数或 VI有多个接线端，因此要注意选对所需的接线端，当所需接线端闪烁时，单击鼠

标即可。将连线工具在两个对象的接线端上各单击一次，就可在这两个对象之间创建连线。

如果已经连了一个接线端，想取消连线，可单击鼠标右键取消。 

：断点工具（Set/Clear Breakpoint），用于在 VI、函数、节点、连线和结构中设置断

点，断点位置将暂停运行。 

：探针工具（Probe Data），用于在程序框图的连线上创建探针。使用探针工具可查

看 VI运行中连线上传递的数据值。 

（6）快捷菜单和属性对话框 

所有的 LabVIEW对象都有快捷菜单，右键单击对象，即可呼出快捷菜单。通过快捷菜

单，可以改变对象的外观或运行方式。比如，选择可见项目（visible items）、为某个输入端

创建常数（create constants）、改变数据精度类型（representation）、设置属性（properties）等

等。 

在快捷菜单中选择设置属性后，会弹出属性对话框，其选项与快捷菜单中的选项类似。 

（7）前面板窗口、程序框图工具栏和程序调试工具 

前面板窗口和程序框图上方都有一条工具栏，上面有运行、中止、调试程序的工具按钮，

它们的用法如下： 

：运行（Run）。如果 VI 有编译错误，此按钮将变成 ；此时单击该断箭头按钮，

会显示错误列表；双击错误列表中的项目，程序中出错的地方会高亮显示出来。 

：连续运行（Run Continuously）。再次单击此按钮可停止连续运行。 

：异常中止执行（Abort Execution）。点击可终止程序运行。 

：暂停（Pause）。单击此按钮后，程序暂停，按钮变成红色；再次单击后，程序继

续运行。 

：高亮显示执行过程（Highlight Execution），只出现在程序框图工具栏中。单击此

按钮，按钮会变成 ，此时，可以看到每个步骤的数据值以及数据在连线上的流动情况。

注意，在高亮显示执行过程状态下，程序执行速度会显著降低。 

小结一下调试程序的常用方法：1）程序编译出错时，可单击 按钮找到错误之处并

修正；2）调试程序时，可以用高亮显示执行过程按钮 检测程序运行情况；3）对于特别



关注的某些数据值，可以使用探针工具 。其它还有设置断点和单步运行等方法，具体请

查阅软件帮助文档。 

（8）快捷键和编程小技巧 

<Ctrl+S>：保存文件。 

<Ctrl+E>：切换前面板窗口和程序框图。 

<Ctrl＋H>：打开帮助窗口（Context Help），当把鼠标放到任何感兴趣的模块对象上时，

就会在帮助窗口中显示相应的帮助信息。 

TAB或 Spacebar：切换选择工具。多按几下直到鼠标变成你想要的工具的形状。 

<Ctrl+Z>：撤销前一操作。 

<Ctrl+B>：去除所有错误的连线。 

如果要观察或改变模块或控件的各种属性，在其图标上按右键。 

双击某个控件/模块可以看到与它对应的模块/控件端。 

（9）LabVIEW试用版和官方使用指南下载地址 

试用版：http://www.ni.com/labview/zhs/ 

简明编程指南：http://www.ni.com/gettingstarted/labviewbasics/zhs/ 

2、 虚拟仪器测量电阻的伏安特性的程序的详细编写过程 

（1）创建前面板 

打开 LabVIEW 2016，点击创建一个 project，并选择 Blank VI。打开前面板窗口，在空

白处点右键，弹出控件选板，在控件选板中选择下列控件，放在前面板上，添加各控件的名

称以及开关状态的标识。 

放上一个 Ex XY Graph（Controls→Modern→Graph），用于显示电流-电压图。将图上方

名字改成“电阻的伏安特性曲线图”，并将横坐标和纵坐标分别改成“电压（V）”和“电流（A）”。

在图的右上角 Plot 0处点右键，选择 Common Plots，选“点+线”模式。 

放入两个数值型输入控件 Numeric Control（Controls→Modern→Numeric），分别用于设

定实验中所采用的标准电阻值和采集时间间隔。放入一个数值型显示控件 Numeric Indicator

（Controls→Modern→Numeric）用于显示测量结果，也就是待测电阻值。分别将上述控件

的名字改成“标准电阻值（欧姆）”、“采集时间间隔”和“待测电阻值（欧姆）”。采集时间间

隔用来设置每次输出电压改变和采集数据之间的时间间隔，让电路充分达到平衡再进行测量。

测量时，标准电阻值设为实际所用的值，本实验中为 100欧姆。在“采集时间间隔”控件上点

右键，选择 Visible Item→Unit Label，此时会在控件右方出现一个黑块，直接输入“s”（输入

前勿点鼠标），这样采集时间间隔成为一个单位为秒的量。采集时间间隔的值可以设为 1 s。

放入一个开关 Push Button（Controls→Modern→Boolean），用于手动控制程序进程。 

加入一个二维数组显示控件，用于显示测量的电压和电流。先放入数组控件 Array

（Controls→Modern→Array, Matrix &Cluster），再将它变成数值型的数组显示控件（创建一

个数值型显示控件 Numeric Indicator，并把它直接放到数组框内），再改变数组维数为二维

（用定位工具向下拖拽索引框使它有两个索引值，或者在索引框上点击右键呼出快捷菜单选

择“Add Dimension”），最后用定位工具向右拖拽数据框使数据有 21列，用于显示测量得到

的 21组数据点。把数组的名字“Array”改成“数据”。 

完成后并输入了参数的前面板如图 3-4所示。 

（2）创建程序框图 

根据实验思路，先输出一个电压，等到稳定后分别测量总电压和标准电阻上的电压。控

制程序执行顺序可以通过顺序结构来实现。在程序框图中放入一个顺序结构 Flat Sequence

（Functions→Programming→Structures），在其边框上点击鼠标右键，选择弹出菜单中的 Add 



Frame After 使顺序结构有四帧，用鼠标拉动边框调整结构大小。之前在程序框图中已经有

一些控件图标，它们分别对应于前面板上的各个控件，现在可以按图 3-5把这些图标移动到

顺序结构的各帧之中。 

首先，让 DAQ 卡输出电压。在顺序结构的第 0 帧中放入一个 DAQ Assist

（Functions→Express→Output），用于输出模拟电压信号，单击鼠标放置图标后程序显示

initializing，之后在生成的右侧对话框内点击 Generate Signals→Analog Output→Voltage，然

后在生成的对话框 Physical内点击选择 Dev1 (USB-6343)的 ao0，表示使用设备号为 Dev1的

设备的 ao0通道输出模拟电压信号，点击 finish后生成界面对输出的模拟电压信号进行具体

设置。首先在中间偏右侧的对话框 Configuration→Channel Settings→Voltage Output Setup内

将 Signal Output Range设置为 0～+10V，Terminal Configuration默认为 RSE，表示输出的电

压信号是 ao0通道相对于地（也就是输出 GND通道）的电压。然后在下方的对话框 Timing 

Settings内将 Generation Mode选为 1 Sample（On Demand），表示该通道一次输出一个固定

的电压值。最后点击 OK 按钮完成设置，程序自动生成相应的子 VI。具体的输出电压值我

们以后再设置。后期如果需要对上述设置进行修改，可以双击 DAQ Assistant图标或者用右

键点击 DAQ Assistant图标再选择 Properties重新进入设置页面。 

然后，让程序等待 1秒钟，用于等待电阻上的电流达到稳定。在顺序结构的第 1帧中放

入一个 Wait(ms)（ Functions→Programming→Timing），再放入一个 Covert Unit（在

Functions→Programming→Numeric→Conversion下），在模块中键入“ms”，用于将单位 s转

换成 ms，将 Covert Unit 的输入端和“采集时间间隔”的输出相连，输出端和 Wait(ms)的

Milliseconds to wait端相联。 

然后，用 DAQ 卡采集总电压和标准电阻上的电压，计算待测电阻上的电压、电流值。

在顺序结构的第 2帧中先后放入两个 DAQ Assist（Functions→Express→Input），分别用来

测量总电压和标准电阻上的电压。单击鼠标放置第一个 DAQ Assist图标后在生成的右侧对

话框内点击 Acquire Signals→Analog Input→Voltage，并在生成的对话框 Physical内点击选

择 Dev1 (USB-6343)下的 ai0，表示使用设备号为 Dev1的设备的 ai0通道采集输入的模拟电

压信号，DAQ 卡外部接线时将这个通道连接到总电压，点击 finish 后生成界面对输入电压

信号进行具体设置。首先在中间偏右侧的对话框 Configuration→Channel Settings→Voltage 

Input Setup内将 Signal Input Range设置为-10～+10V，Terminal Configuration选择为 RSE，

表示输入的电压信号是 ai0通道相对于地（也就是输入 GND通道）的电压。然后在下方的

对话框 Timing Settings内将 Acquisition Mode选为 N Samples，并将 Samples to Read的值设

为 1000，表示一次采集 1000 个样本，后面我们将把这 1000个样本的平均值作为一个数据

采集点的结果，以提高信噪比；Rate（Hz）也设为 1000，表示测量速率是每秒 1000个样本，

这样采集一个数据点也就是 1000个样本需要的时间是 1 s，点击 OK按钮完成设置。对第二

个DAQ Assist做类似的设置，只是在对话框 Physical内改为选择Dev1 (USB-6343)下的 ai1，

表示这个子 VI使用 ai1通道采集输入的模拟电压信号，DAQ卡外部接线时将这个通道连接

到标准电阻上的电压。两个采集信号的 DAQ Assistant设置完成后，将前一个 DAQ Assistant

的 error out输出端连接到后一个 DAQ Assistant的 error in输入（将 DAQ Assistant图标的下

沿向下拉可以显示出全部输入、输出端口），通过上述 error数据流的设置，可以控制程序的

同一个部分按照 error数据流的顺序先后运行多个数据采集过程；否则，如果在程序的同一

个部分同时运行多个数据采集过程，采集卡无法正常工作，程序将报错。上述两个数据采集

的 DAQ Assistant得到的结果是 1000个数（因为前面的 Samples to Read的值设为 1000），需

要对它们求平均值，放入两个 Mean（Functions→Mathematics→Prob＆Stat），把两个 DAQ 

Assistant的 data输出端和Mean的 X输入端相连，则Mean的 mean输出端输出的是电压平

均值。连线时由于 DAQ Assistant的 data端输出数据类型与Mean的输入数据类型不同，连



线时中间会自动出现一个数据类型转换节点。之后用总电压的平均值减去标准电阻上的电压

平均值得到待测电阻上的电压，再把标准电阻上的电压平均值除以标准电阻，得到电流值。 

然后，再让程序等待 1秒钟，以减少对数据测量过程的影响。在顺序结构的第 3帧中放

入Wait(ms)，在Wait(ms)的输入端点右键创建常数，选择 Create→Constant，并将其常数值

改为 1000（表示等待 1000 ms）。 

利用上面的顺序结构我们只完成了一组数据点的测量过程，实验中我们需要逐渐改变电

压，获得电阻的一条完整的伏安特性曲线。下面我们来实现电压值的改变。 

我们通过While循环来实现电压的改变。放入的While循环要包含先前的顺序结构、“数

据”和“电阻的伏安特性曲线”。先在 Functions→Programming→Structures 下单击选择 While 

Loop 控件，然后在程序框图中，在顺序结构左上角以外点击鼠标左键并按住，向顺序结构

右下角拖拉 while循环框，将顺序结构等对象完全包含之后释放鼠标左键，这样就把顺序结

构等对象放在了While循环中。或者，先放一个空的While循环，再用定位工具拉出一个框

框住整个顺序结构，把它拖进While循环中。（如果你操作失误，可以用快捷键 Ctrl+Z撤销

操作；如果你只想删除While循环结构，而保留其中的顺序结构，可以在While循环边框上

点右键，在快捷菜单中选择 Remove While Loop）。我们希望 DAQ卡输出电压从 0 V开始增

加到 5 V，每隔 0.25 V测一组数据，可以在While循环框左下角放入Multiply（乘法）函数

（Functions→Programming→Numeric），将循环变量 i 连入乘法函数的左下输入端 y，在乘

法函数的左上输入端 x用右键创建常数，然后用右键点击常数，并选择 Representation下的

DBL将常数的数据类型由整型数改为双精度浮点数，再将常数值设为 0.25，最后将 i和 0.25

的乘积也就是乘法函数的输出端与顺序结构第 0帧中的 DAQ Assistant的 data输入端相连，

从而控制 DAQ Assistant输出的电压值。While 循环的循环变量 i从 0开始计数，循环条件

在框内语句都执行之后才进行判断，因此While循环至少执行一次。要限制电压范围不超过

5 V，可以把 While 循环的 i 和 20 做比较，也就是放入 Greater?（大于）函数

（Functions→Programming→Comparison），将循环变量 i连入函数的左下输入端 y，并在函

数的左上输入端 x用右键创建常数，将常数值设为 20。Greater?函数的输出结果再和开关控

件作逻辑与运算（And函数，在 Functions→Programming→Boolean 下）后和While框内右

下角的循环条件端子相连，用于控制循环。注意用右键点击右下角的循环条件端子把循环条

件设为 Continue If True。 

用移位寄存器 Shift Register实现数据的传递和实时显示，Shift Register的功能是在相邻

两次循环之间传递数据。在While循环左边框（或右边框）上点右键选择 Add Shift Register

加上两个 Shift Register，分别用来存储并传递电压和电流的测量数据。在循环中放入两个

Build Array（在 Functions→Programming→Array下），向下拖放其图标使其有两个输入端，

将图标上方的 element端口和左边的 Shift Register相连、下方 element端口和电压（或是电

流）相连，图标输出端 appended array和右端的 Shift Register相连（此处 Build Array的作用

是将来自下方 element输入端的新测量数据与来自 Shift Register的原来一维数组中的数据串

成一个新的一维数组）。注意在左右两端 Shift Register之间的线完全连好以前，连线会显示

为断线；两边都连好之后，连线才会显示正常。分别在左边两个 Shift Register的小三角上点

右键，选择 Create→Constant，创建两个空的数组，并将值设置为 0，用于初始化数据。 

显示测量数据。在程序框图再放入第三个 Build Array，向下拖放其图标使其有两个输入

端。把之前两个Build Array输出的电压和电流数组分别和第三个Build Array的输入端相连，

把 Build Array的输出和名为“数据”的数组显示控件相连（由于输入的两个一维数组大小相

同，此处 Build Array 的作用是将来自两个 element输入端的电压一维数组和电流一维数组

合并成一个二维数组）。 

显示伏安曲线。把 Build Array输出的电压一维数组和 Build XY Graph的 X Input相连，



电流一维数组和 Y Input相连。由于显示数组控件“数据”和显示图形控件“电阻的伏安特性曲

线”都在While循环以内，因此每次循环“数据”和“电阻的伏安曲线图”都会更新一次。 

计算电阻值。在While循环外面放入一个 Linear Fit（在 Functions→Mathematics→Fitting

下），将While循环的右边框上的 Shift Register传递出来的电流数组和 Linear Fit的 X 输入

端相连，电压数组和 Y 输入端相连，把 Linear Fit的 Slope输出端和“待测电阻值（欧姆）”

显示控件相连，显示线性拟合得到的电阻测量结果。 

完成测量后，可以在前面板中显示结果的曲线图上点击鼠标右键并选择 Properties，然

后在弹出的窗口中调整曲线图的显示范围和显示数据的精度等。 

3、 自动化弗兰克-赫兹实验的连线方式 

由于所有放大器的负接线端和 DAQ卡的模拟输入地和模拟输出地都是接地的，所以设

计接线方式时必须考虑共地问题。灯丝电位与各个电极独立，不用加以考虑，直接用弗兰克

-赫兹实验仪的第一个直流电源供电即可（灯丝电流为安培级大电流，DAQ卡无法直接提供）。

首先考虑板极 P，实验中板极电流通过弱电流放大器放大后由 DAQ卡探测，具体来说是通

过同轴电缆输入到弱电流放大器的输入端 IN。此时，板极 P 与弱电流放大器的正接线端相

连，而弗兰克-赫兹管的地与弱电流放大器的负接线端相连，也就是电势等于零。考虑到弱

电流放大器基于集成运算放大器工作，本身输入阻抗很小，因此弱电流放大器输入端的正、

负接线间的电势差近似等于零，于是板极 P 的电势也近似等于零。实验中要对电子形成加

速，阴极 K的电势必须远低于板极 P，考虑这一点，加速电压放大器的正输出端必须输出一

个负的高压信号（其负输出端的电势已经固定在零）。为此，在我们的设计中，要求将 DAQ

卡输出的一个正的电压信号输入到加速电压放大器，也就是将DAQ卡的模拟输出端口AO 0

和模拟输出地 AO GND分别连接加速电压放大器同轴电缆输入线的正、负接线端，正电压

经加速电压放大器内部的高压运放放大为一个负的高压信号。然后将加速电压放大器输出同

轴电缆的正接线端的负高压信号连接到弗兰克-赫兹管的阴极 K，输出负接线端的地连接弗

兰克-赫兹管的地端口，即可使阴极 K的电位远低于板极 P，从而在阴极和板极间的某些区

域形成电子加速区。 

具体来说，对于第一激发态的测量，要求电子加速区位于第一栅极 G1 和第二栅极 G2

之间，而阴极 K和第一栅极 G1之间加一个小的加速场用来消除阴极热发射电子的空间电荷

积累效应。此时，只需将电位浮动的弗兰克-赫兹实验仪的第二个直流电源的正、负输出分

别连接到 G1和 K，即可在 K和 G1间产生一个大小可控的加速电场。而第二栅极 G2与板

极 P之间的减速电压通常不大于 10 V，可以由 DAQ卡直接产生，故只需将 DAQ卡的模拟

输出端口 AO 1连接到 G2，并在该端口输出一个正的电压信号，使 G2的电势高于 P，从而

在 G2和 P之间形成减速电场，其大小可以通过在电脑上改变端口 AO 1的输出电压直接控

制（P的电势近似为零，因此 AO 1的输出电压近似就等于减速电压 UG2P）。当电脑控制端

口 AO 0的输出电压从零开始逐渐增加时，阴极 K的电位不断降低，而电压 UKG1、UG2P均

保持不变，因此电压 UG1G2不断增加，也就是在第一栅极 G1 和第二栅极 G2 之间形成加速

电压不断增加的电子加速碰撞区。 

对于信号的采集过程，板极电流 IP经弱电流放大器放大为电压信号 Uout，然后由 DAQ

卡的 AI 0 通道直接采集，并作为弗兰克-赫兹实验曲线的纵轴；扫描电压 Ukp为高压信号，

不能直接采集（DAQ卡最大输入范围±10 V），因此实验中是由 DAQ卡的 AI 1通道采集加

速电压放大器放大前的输入信号，然后在程序中乘以加速电压放大器放大倍数得到 Ukp，并

作为弗兰克-赫兹实验曲线的横轴。 

而在测量汞原子高激发态的实验中，除了要降低汞管的温度，从而降低汞原子密度，降

低电子与汞原子的碰撞概率，还需要将电子加速区移到阴极 K和第一栅极 G1之间，并在第

一栅极 G1和第二栅极 G2之间加一个很小的正电压（0～1 V）构成自由碰撞区，使电子有



更大概率在高能量状态与汞原子发生碰撞从而激发汞原子的高激发态。此时，只需将第一激

发态实验中弗兰克-赫兹实验仪的第二个直流电源的正、负输出端改为分别连接到第二栅极

G2和第一栅极 G1即可。由于电压 UG1G2和 UG2P均保持不变，因此当电脑控制阴极 K的电

位不断降低时，电压 UKG1不断增加，也就是在阴极 K和第一栅极 G1之间形成电子加速区。 

4、 自动化弗兰克-赫兹实验的程序编写 

弗兰克-赫兹实验程序可以在电阻测量程序基础上修改而来，修改后的前面板和程序框

图分别如图 3-6和 3-7所示。整个程序框图的主体是一个包含四帧的顺序结构：第 0帧包含

两个 DAQ Assistant，用来首先输出反向电压 UG2P和给扫描电压设置初值 0；第 1帧是等待

1 s，用来稳定反向电压 UG2P；第 2帧大体是前面的电阻伏安曲线测量程序；第 3帧是后处

理，将输出的反向电压 UG2P和扫描电压归零，并将测量的数据结果存入文件。其中第 2 帧

中的循环控制条件根据新设置的控制变量做了相应的修改，改为由起始扫描电压、扫描电压

间隔、终止扫描电压和最大允许信号电压控制（考虑到信号电压可正可负，判断是否达到最

大允许信号电压要先取绝对值再比较）。另外要注意的一点是，考虑到弗兰克-赫兹实验曲线

数据点比较多，第 2帧中用来采集输入电压信号的两个 DAQ Assistant在最初设定样本采集

速率时可以将 Rate（Hz）都设为 10000，而采集样本数 Samples to Read仍设为 1000，这样

可以将曲线中单个数据点的采集时间减少 10倍，从而减少整条曲线的采集时间，当然考虑

到弗兰克-赫兹管本身的响应速度，上述采集时间也不宜减少太多。第 3 帧中将测量结果写

入文件可以采用 Functions→Programming→File I/O下的Write Delimited Spreadsheet函数，

在第 2帧内再新建一个 Build Array，将之前的电压 UKP和 Uout的两个 Build Array的输出分

别与这个 Build Array的上下输入端相连，将其输出端口与Write Delimited Spreadsheet的输

入端口 2D data相连，采集程序运行完毕后会弹出文件保存窗口，此时可以将测量得到的二

维数组保存为 txt格式的文件以供进一步后处理。注意Write Delimited Spreadsheet函数默认

的写入方式是横向写入数据，需要到 Functions→Programming→Boolean 下选择 Ture 

Constant放入程序框图，并将这个布尔常量与 Write Delimited Spreadsheet 函数图标下方的

transpose? (no:F)端口相连，则函数以两列的方式沿纵向将二维数组写入到文件中。 

 

图 3-6自动化弗兰克-赫兹实验前面板图 



 

图 3-7自动化弗兰克-赫兹实验程序框图 

 


